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This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.
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Main menu Sub menu
VGA
— Input |:
DVI
— Picture — Picture Format — Wide screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartContrast — On, Off
— Gamma — 1.8,20,22,24,26
Col — Color Temperature — 5000K, 6500K, 7500K, 8200K,
+— Color
9300K, 11500K
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English ,Espanol, Francais, Deutsch, Italiano,
Portugués, Pycckuin, &1 H13C
— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
— Transparency — Off, 1,2,3,4
— OSD Time out — 5,10, 20, 30, 60
L— Setup [ Auto
— Power LED — 0,1,2,3,4
— H. Position — 0~100
L V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
— Information
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Wizard

You'll need to calibrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves a series of steps that wil let you
tune your display and save the settings.

1. Choose the Start Wizard button.

2. Folow the steps outlined in this process.

3. Save your settings for future use.

Adijust Preferences

Audio

Color Auto Pivot

Presets

#

Theft Detemence

wd

Multi Monitors

Help Start Wizard

B ERmERS

Adjus (1A% ) 8

o TEATLARIH Adjust (138) 2 5k 1)
FEBrightness (5¢/). Contrast (X] kb
FE). Focus (GEAE). Position (1. &) Fl
Resolution (7 ##%) .

o Rl DAR RS S U A T TR
«  Cancel (HUH)#7s I A2 15 HUH 222358

B smartControl 7%

SmartControl Premium PHILIPS

Brightness

Improperly adjusted Brightness wil resuft in a loss of
detall in darker image areas. Adjust the Brightness for
the best possible picture gualty.
1. Lower the Brightness to the minimum level.
Adijust 2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Color

Contrast

o
R
Foot Brightness

=+ s

Position
) Undo Reset

"

Resolution

Options

Help

B smartControl

SmartControl Premium

]

Adjust

Brightness

Color w

Contrast

2

Eco

|
5
2
o
@
L

w

Resolution

Lﬁ"

‘Options

%

Help

B8 smartControl

SmartControl Premium

ad

Brightness
Color
Contrast
\g * Foas
Eco
% Position
=
@ Resolution

‘Options

oy

Help

B smartControl

SmartControl Premium

a

Brightness
Color

%

Contrast

28

Eco
- Position
— PR
\g Resolution

‘Options

%

Help

PHILIPS

Contrast

Adjust the Contrast (use the slider) to keep details in
lighter image areas.
1. Raise the Contrast until the numbers 1 and 2
are no longer visible.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble.

Contrast

Undo Reset

PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visible, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust ta the brightest setting to minimize
movement on the screen.

Pitch 50
= &
Phase =]
= &
Undo Auto Setup
PHILIPS
Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
horzontally.
Undo Reset
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Brightness

Color

%

Color (s ) €82

(=]

PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display ta show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.
If your display is at 3 Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

™ Enable Resolution Notifier

Picture Format
™ 4:3 aspact ratio

Preferred

o HEETLUF) F Color (Hih) 3k FLif 3%

RGB. Black Level (

BN White

Point (4 5i)~ Color Calibration (Zii
ERHE) . LA Smartlmage (12 L

Smartlmage —17)

o R DU R S WA T I
o WRAERA, ST ERPR TR
+ Color Calibratio (Bt #E) 75441

B smartcontrol

SmartControl Premium

“"ReB

Black Level

White Point

Display Gamma
!
Calibration

ap

Options Smartimage

Help

PHILIPS

RGB

Al displayed colors are produced by mixing Red, Blue,
and Green at different brightness levels. Choosing a
neutral White Point wil give you optimal RGB. If you
prefer to adjust the RGB now, follow these steps:

1. Adjust the intensity of the Red, Green, and
Blue using the slider bars.
NOTE: Changing the RGB values can adversely effect
the displayed colors.

Red 100

=) b

Green 100

= ol

Blue 100

o Ui
undo Reset

x \

B smartControl

SmartControl Premium

Black Level

Whle Point

Display Gamma
-y
Calibration
ap

Smartimage

8 smartControl

SmartControl Premium

Black Level

White Point

Eco Disphy Gamma

!
Calibration
ap

SmartImage

B smartControl

SmartControl Premium

Black Level

e

White Point

=]

Display Gamma

Calbbration
ap

Smartimage

=

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intensity create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.

1. Please select the White Point value for the best
possible color gualiy.

White Point 6500K
= o J
Undo Reset
7%

PHILIPS

Display Gamma

Gamma is 2 component of the pixel brightness in a
display. A lower Gamma value produces brighter pixels
and a higher Gamma value produces darker pixels. The
default value for Gamma is 2.2.

To adjust Gamma, Smartlmage must be set to Off.
Ciick the SmartImage Off button before adjusting
Gamma.

1. Use the slider to select the desired Gamma.

Display Gamma 2.2
= b k.

Smartlmage OFf

Undo Reset

7%

PHILIPS

Calibration

Your display needs to be properly calibrated in order
for it ta produce the widest range of calors accurately.
(Calibration should always take place as the fast tuning
step in the process. Remerber to recalbrate any time
you make individual adjustments to image quality or
whenever you move your display to a new location.
1. Make all other necessary adjustments to image
quaiity first.
2. Press Show Me to learn how to use the
calibration tooks.
3. Finally, press Start to begin the calibration
process.
¥ Enable color calbration
Color software designed in colaboration with Joseph
Holmes.
Protected by U.S. Patent No. 6,686,953

Show Me Start

Quick View



3. E&RMIL

1. “Show Me (7R)” JA BB A HEZL
o

2. Start (JFUR) - ;3 6 R HELFE .
Quick View (PRI A E) N Hi/ 2 J5 1)
S

4. WMELRMEIBEEER, LU Cancel
() #4

5. JHHBUERHE - EERUIEDL NP E . 4
A, WA SEVFHAT B EAHE, FHaA
HP I A 2 AR o

6. B %E LR R BRI R

E—TEOeRERS

o TERIREE AN SRR AT,
“Previous ((F—A)” $2H1I#EEH

o “Next (F—” HEANJGIHEHFR
(6 MHIR) -

o IJaiEN “File>Presets (SCA>TAH)
7

o “Cancel BUH)” RHH A FH, IR
EIEGRERI

14

Smartlmage

JEVEHT AR5 P 7 S SO DA B B A 1Y
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SmartResponse.
/-Smancuntml

SmartControl Premium

RGB
Eka!w Level

White Point

Display Gamma

-

Calibration

@,’Z

ECO

[z
8 smartControl

SmartControl Premium

Adjust

=

Color

Power Savings

Eco Schedule Power Savings

]
,,i ,‘i
Options

Help

ot

PHILIPS

SmartImage

SmartImage provides different brightness and
contrast levels to accomodate today's wide range of
computer applications.

Choose the setting that is most comfortable or
efficient when viewing your application. Alternatively,
simply choose the one that best describes s type.

Off Office
= A
Photo Movie

Economy Game

PHILIPS

Schedule Power Savings

When powered on, the display is using power, even if
the screen is black. Adjust the settings on this pane to
minimize the power usage during inactivity.

r ¥ Timer
Idle Timer - Use the Idle slider to set the standby

mode timer. After the screen goes dark, any mouse
or keyboard activity restores the desktop.

Power Off Timer - After the display enters standby
mode, the Power Off Timer begins to count down.
Use the Power OF sider to adjust the length of time
before the display is automatically turned off. Note

r W Schedule Daiy Power Off
Select the time and day for the display to Power Off
lautomatically.
17:00 »] | Monday I” Tuesday I~ Wednesday
I~ Thursday I Friday
™ Saturday I Sunday

Tdle never

=0 b

Power Off 0 minute

(=8 &
Standby Now Tum Power Off Now
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Theft Deterrence

n Numher

il
(PI). Ir the display is removed frnm h\s computar,
this PIN is needed to authorize use on another
computar.

Preferences

Audio

Auto Pivot

Tnput

Theft Deterrence

o

Multi Monitors

Theft Deterrence Disabled

Help PIN Options Enable Theft
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Theft Deterrence

- Theft Deterrencs
unautl
The&

. @ will require

(DIN) If he dlsmay 3 remn\ed from this computer,
this PIN is needed ta authorize use on another
computar.

e protects you d D|V against
wuu r. To Enable

L Tt it
IId ntification Nurmber

Color Auto Pivot
. \!
\g -
Eco Wizard
. 4
” 2
= Presets
Options Theft Deterrence
Multi Monitors
Theft Deterrence Disabled
Help PIN Options Enable Theft

T

f1% PIN J5, Theft Deterrence ( B #5 ) it
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Preferences

You can use the following options to configura
SmartControl.

¥ Enable menu when right-clicking on desktop
¥ Enable task tray menu

¥ Run at system start-up

Set Trensparency:

® 0% © 50% © 100%

U ?‘! 2
Adjust Prefarences

Audio Select language:
English -
SmartContrast
Gn Auto Pivot € On: SmartContrast
& Qff: Economy
Y
PowerSensor Settin
Input f——*ﬁ
3 ~
k Power LED Button Brightness 3
Wizard - O 3
2
Prasets

#

Theft Deterrence

\Q Multi Monitors
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FEAL) I, Task Tray ((E45HE4E) Bl bt A
WoRExit GRHY).

TEERNE LR, 1 On (FF)A) Run

at Startup (JABhINE1T). M2k

i, SmartControl Premium 7 )3 2l i A
1247, WATETask Tray (£G4«

JA 8l SmartControl Premium [JME— 77 2
T MR TR TT A BNFE 2 30 ANik
O HE (CZERD I, AN E AR
JA BN IEAT (R AR .

Ja FE A (Windows 7/Vista/XP) .
BRME A 0% AIEH

16

Options>Input (IEIR > N ) - 1249 M
Options (JET) F 7 P IEHE Input (FTA)
NPT H o FEASCRAN Wonds (3CFF DDC/
Ch E, XA Help (#58)) F1 Option (£ )
bRZEvT o BT HoAth SmartControl Premium
PREEHBANTT H o

8 smartContral #ix

PHILIPS

SmartControl Premium

Adjust Preferences
\g Audio
Color Auto Pivot
\ Y
\g b
Eco Wizard
5 “a a
; ¥
Presets
F Ex‘
eterrence

Options

\g Multi Monitors

Help Analog In Digital In

o o AU I AR R 2 i AU
B

ERARANET b, BRI,
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Options>Audio (IR > &3 ) - 1M

Options (& ) 47

INETPRE

SEEHE Audio (A

FEASCHRFIN g (38F DDC/CD E,
A Help (#Bh) Fl Option (&I #5325 T)iﬁ

B smartcontrol

SmartControl Premium

Adijust

S

Preferences

@ .y
Color Auto Pivat

B 'n‘ e

\g Input

Eco Wizard

i f 2
- Presets
I

Theft Deterrence

i
Options
\Q Multi Monitors

Help

Option>Auto Pivot ( i

- SmartControl

SmartControl Premium

&

Adijust

Preferences
@ Audio
'

Color Auto Prvot

e S
Input

IR

Options

L

Help

PHILIPS

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

off the tgmtd\ udspeakers by checking the
Mt checkbor

™ Mute

Volume

= =
| E=}

EI > BRIl S)

PHILIPS

Auto Pivot

To manually rotate the screen image, click a rotation
button

Uncheck the Auto Pivot box to disable automatic
screen-image rotation.

™ Enable Auto Piat

180° 270°
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Help> User Manual (%581 > RPF) -
UM Help (58 ) T H 1% User
Manual ( M) BT o AEASSZRRR) 2
e (ZFF DDC/CD B, HA Help (#8)h)
Fl Option( &I ) brZ5AT FH

8 smartContral 21X
SmartControl Premium PHILIPS
User Manual
1f you need help setting up of pmHgSmart[ ntrol,
citk the TechSppurthrr . You'l have the

aption to fil out an Assistance Form.

Adiust You can also choase to have information about your

software automatically attachad to the assistance
form. You'l need to be online to use this feature.
Usgnua\
®

“
Update

-
Display 1D

Eco
g 2.

Color

S System ID
.
b &
Version
‘Options
— g x
Help User Manual Tech. Support

Help>Version ( # B > ARA ) - {1 M Help
(B ) TR HHIE Version (A ) W AT
Mo TEASCHFRI Wy (387 DDC/CD L,

WA “Help (#8))” Fl “Option (3£ )”
ﬁ G

8 smartContral 2%

SmartControl Premium PHILIPS
Version

SmartControl

Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

Adijust DDC/CI Communication: Yes - PDI API

Copyright © 1993-2009 Portrait Displays, Inc.

User Manual

1]

Color
Update
Display ID

System ID

B

Eco

€

Version
Options
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Context Sensitive ( £ T3 KEk ) €8
Context Sensitive (=~ G ) SEHRAEBRIA
LA H . W3R AE Options>Preference
(BT > HILEI ) EAS LS T Enable
Context Menu ( JAH L F 30, F iR
ZKHL

g SmartControl
Select Presat 4
Tune Display

R SCERA 4 ANTH -
e SmartControl Premium - 24iEF0f,
TRIET B o

* Select Preset (IR {H) - &4t CIRAF
ITRB A I 2 e B, X TR mT LA
SERIME . R bRl KR AT IE R I I
WAH. Bk, 3] LLR 72 5 i
T A

Tune Display (A% & 7R) - 4T
SmartControl Premium 4% il [ A o

*  Smartlmage — fu A YT W E: Office
(732)~ Photo (M) Movie (B2 1)

. Game (Jlfxk)~ Economy (&%) Off
(K1),

Task Tray (1E5#EE ) 225 H

ARl Task Tray (AE5FERD) IR

SmartControl Premium BFRES, 7R Task

Tray (fESSHERL ) S, Wl L8 5 3h Y

M.

Help
Technical Support
Check For Update

About
Exik
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Task Tray (fE55FL4L ) 17 5 NIIH »

« Help (FBh) - Ui F M0 A
BRI 0 2 i 11T T User Manual (HH
SIS

« Technical Support (FZARIZ#F) - REiAR
SCRE U

Check for Update (Fa & & #f) - i ) &
S E POI A 25 22 1547 S8 RS

«  About (KXF) - WorTEHIMNZHEAE
PR RATAE B BLAG™ i A4 FR

« Exit GBH) — P SmartControl Premium

W FIRIELT SmartControl Premium, B8

MProgram (F£)77) % HLH & FE SmartControl

Premium, BU#H X PC S 1 EIbR, B0 H

Hriash R 58 .

PHILIPS

'®
SmartControl

SmartControl
Version 3.20
chune-stardiard-R2007-01-04-1151-23
Copyright 1983-2007 Portradt Displaye, Inc.
Patents Pending

Task Tray (25488 ) KEEH

AL IO A A Task Tray (1T
SAERL ) I, BN Exit (1B H ) BT,
BRI Task Tray (fE45F6HL) H

M SmartControl Premium, B PLEE
Options>Preferences ( LI > LI ) HH2E
A Run at Startup ( JAZIIIEAT) »
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3.4 SmartDesktop 35

El SmartDesktop

SmartDesktop 7t SmartControl Premium
1, 223 SmartControl Premium, X5 M
Options (£ ) HHiEFE SmartDesktop

[ srartarin Praun QX
SmartControl Premium PHILIPS

SmartDesklop

o Select desktop partiioning mode.
K Algn to partiion

o M DA R XX A, Align to
partition (HEZ 273 1X) B IEHEREDS X
LT B8

o AT EBRATERET T X . A DO
TR, BB E i

o« Identify (R $&HE T A A WS I TR IE
5k

‘
rE LW s
40 up kD
-
:J » o et .- &
s P n a
T T Y T T e T e T T o T T
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B #EREO

— HOR AR IXCREAT T L T T 4% Align to
partition (FFFIEI3 X ), WK E H a5 2%
D ek B & F0R BB HES E HR EURR O
FRAEAZIX IR I, %X ok B 5 s o

6 i

an FA B T LI AR B X AME, )

Show windows contents while dragging ( #3])

IR TN ) 25 . s

1. 4£ Control Panel (¥ HfitRk) H, P
System (R4).

2. BiimB ARG wE O Vista T Win7 #
YE&RG:, wIAEAMiarerpds) .

3. 1E Performance (P£RE) X1, il
Settings (W 'H.) o

4, FEMEF, ' Show window contents
while dragging (W3 EIR T LT 7Y),
SR Ll OK () »

HEBRBE:

Vista:

FEIAR > A4 > & BTSN >

iy “IT A IS 1 LA AR B 2 i ik

W7 > My “RORT 7L > 1k “Hshin

BIREHNE”

XP:

SREE > S0 > AR > B “HEEI
SRE LA

Win 7:
TeHe BB .



3. Bigik

Bl FREA= R

Desktop partition ( S 4r X ) A i3 %

b Vg i) o SR RESR AL T PR T
JIERAE BRI DL SR A 87 FUAIE BT
o XM E sl K5 Iehni2 2 2% 3h
F R bR A= LAV )R hz e 4

ey

B AEBRTRE
A # it Desktop Partition (5[ 431X )
L D Sl N VA

Find Windows ]
Desktop Partiion  »
Identify Partition

*  Find Windows (B & O) — 7 LE1E ML
N, PR AN HIRR] TR —
ANG3IX e Find Windows (T35 1) K 2
ANTATIFRE D, R ITE R O
2 2] f5¢ i T o

+ Desktop Partition (R %3 [X) — S [f 7 [X.

BN AP o X, IR PR
B R R R AR X

65 d9-0 ¢ it
- Home et

siings  Revew  View 3 Partison i
- R deatdy Partifion
2 W ls| AP AaBbCc | AkmOK E
- :’R:H’ﬂ{\:‘f- eading 1 Exat i
Z Styles
SmartDeskiop Guide m@
SmartDesktop ~ SmantDesktop is in SmartControl Premium. Install SmanControl Premium and select E
SmantDesktop from Options ﬁ
[ ] smartConteat Premion @i

SmartControl Premivm PHILIPS

Find Windowr ﬁ =T
Deskiop Partison. *

«

Gil

6 i

ISR T A oR g, P ATEERE
BRSO AN . e R I R kR R
MRS X

* Identify Partition (IR 3l 53 [X) — W7~ 41l
I3 DS E R PR AE .

*  Align On/Align Off (HEFIFF IR /HEF1 3K 7])
— Jo /AR S A s AR DR

«  Exit (BH) — JCPA 5L 70 XA s
o MEFEFHIA, WA TR
SR B PREE T R 3 Display
Tune (27REE) .

B fRpEHExs

ekt FL T Desktop Partition (548X ) K]

B PR B B R A A& BATA 73 X T

i BB AR R T AR B v

zNIFi P




A Task Tray (1E54EE ) AR E

Task Tray (fE45464% ) A b= v SCRF
2 B )Re ((H 8RR a1 AL BITA 70 X B
A )

Find Windows
Desktop Partition
Identify Partition
Align Off

Bright Light

Dim Light

Help

Technical Support

Check for Update
About
Exit
L
L]

Find Windows (& & O) — 7& 52845 00
N, PR AN HIRR] TR
ANGrIX . Find Windows (Fr$k i 1) K i
NPT TG 1, R BT e 1%
EE TP

* Desktop Partition (R H % [X) — 5 [f 7 [X.
R R TER 73 X, Ik P s
BN R H R R AR AT 20 X
Identify Partition (1IR3l 43 X) — 2715 24 7if
3 DX S F ) R AE .

Align On/Align Off (HEFIFF IB/HEF! 5K A])
— JA HAE A A sh 5 D) RE .
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SmartDesktop 73 X 7E X

AR 15t BA
Full Desktop VP A BN FH B AN HL T
(BB )
Vertical VPG B o R IR B s BE 0 B AN KN 5e 4 AH [
(HEH) [ERENS
90/270 FETERENT, PRI HACE .
Horizontal VP B 2 0 R I B B 0 O AN KN 54 AH R
(7KF) 7K X 3

90/270 FEhekit, RFF/KTHE .

Vertical Triple
(EE=77)

PPN 5 5 20 R IR o B o = K/ se Al A
O X 4

90 FEEREIE, J3IX 1 AEACETIHE, 73X 2 AEKF A
Ry X3 FEKPEH

270 FETfemt, DX 3 ARSI, X 2 7EK
e, 23X 1 AR

Vertical Split Left
(EEIEA)

PPN 5 20 MR R o B o o A T L X, e
A BAS IR, A5 BRI AS KN 58 A A TR (1 DX

90 FElgkeit, DX 1 AR, 731X 2 A1 3 AR .
270 FEJERems, DX 1 AENRHS, 20X 2 A 3 AETH.

Vertical Split Right
(EETEA)

VPG I e 0 R IR R B o B A T L X, A7
A BA I, FEIL 5T B AS KN 58 A AR TR [ X

90 FEEEEN, 43X 1 A 2 LETHI, 431X 3 LERCH.
270 FETRFES, rIX 3 ETES, X 1 Fl 2 ZEJKHR .
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AR

Horizontal Split Top
(ZKP 2 FIT0E )

15 A

PP B e 0 A I W7 B 23 B A KN 58 4 ]
FRIZKP DXk, TS Ay BN X, R DX 4k e P A
P AN I E e

90 FEgRE, X 1 EALMEE, 5 2 M 3EL
SUEI A

270 FEghent, X1 fEAEAHEE, X 2 M3 AE
VEpUEI IR

Horizontal Split
Bottom

PP e 0 A TR 7 5 23 B A K/ 58 4 A ]
PRI DXk, Je i oy BN DX, T8 DX 48 P A4

(ACEAEERR ) KN FEAAH A ) X35k
90 JEHERENT, X 1 M2 fEAILTEE, 70X 3 EA
SUEI A
270 BENREEN, AFIX 1 f 2 fEAH R, 42X 3 1E
VEBUEIH=1P
Even Split PPN BEE 00 HER A o B 43 DU AN K /N 58 4 A ]
(F¥5E) R X 3K
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4. FARHE

22153/221S31/221S3L™

WoR A AR TFT-LCD

=izr CCFL (221S3) / LED (221S3L/221S3L"™)

NG 21.5"W/( 54.6 cm)

i e LG 16:9

BE A 0.248 x 0.248 mm

S 300 cd/m? (22153) / 250 cd/m? (22153L)

SmartContrast 500,000:1 (22153) / 20,000,000:1 (22153L/22153L™)

xRS (B 1000:1

Mg 57 B[R] CHLTR) 5ms

AR 19201080 @ 60Hz

A 176° (H) / 160° (V) @ C/R > 5 (221S3)
176° (H) /170° (V) @ C/R > 5 (221S3L)

J B i Smartlmage

BoRE AR 1670 )i

BN ES 56Hz -76Hz

SRS 30kHz - 83kHz

sRGB T

(CREE TN DVI ($5) . VGA (55)

AN ERE] SR, S

FH g% Smartimage/¥ Brightness ( 52/ )/a. Power On/Off (17T /
KPR ). E=l/back (JZ[F] ). Menu (OK) (. (i) )

OSD &= PR VRV R RORANE . MRE . PRYEE . AP,
%

R4 ED H e A 1 DDC/Cl, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

iRt -5/ 420 (22153/221531/22153L™)

Jig# -65/+65 (221S3L™ CEB base)

o P 70mm (221S3L™ CEB base)
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221531/22153L™

i GRIEPE) (WxHXD)

507 x 400 x 201 mm

TAEREE 201W (LAl
AE R TG ENES BRGNS R TGN
(EnergyStar 5.0 MR J775) 100VAC +/-5VAC, | 115VAC +/-5VAC, | 230VAC +/-5VAC,

50Hz +/ -3Hz 60Hz +/ -3Hz 50Hz +/ -3Hz

IEHIEAT (HLA) 16.81 W 16.67 W 16.60 W

(EiE 01W 01W 01W

AN 01W 01W 01W

A * TR ANGENES R TGRS TR TPANGENES
100VAC +/-5VAC, | 115VAC +/-5VAC, | 230VAC +/-5VAC,
50Hz +/ -3Hz 60Hz +/ -3Hz 50Hz +/ -3Hz

IEHIBAT 57.37 BTU/hr 56.89 BTU/hr 56.65 +BTU/hr

(HilE 0.34 BTU/hr 0.34 BTU/hr 0.34 BTU/hr

AT 0.34 BTU/hr 0.34 BTU/hr 0.34 BTU/hr

HJE LED FR7n4T THEER: A, HFHL ERER. At VR

GV W&, 100-240VAC, 50/60Hz

221S3L

P (AFEE) (WxHXD)

507 x 323 x 59 mm

ALFE RS (WxHXD) 565 x 461 x 131 mm
Peh CR R 3.85 kg
7o AR 344 kg
e (B3 518 kg

221S3L (CEB base)

P (FEJE) (WxHXD)

507 x 400 x 220 mm

P (NETEREE) (WxHXD)

507 x 323 x 59 mm

A5 N~ (WxHIXD) 565 x 466 x 175 mm
P CRJRRR) 483 kg
77 (NS R 346 kg
RSN 6.67 kg
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4. AR

WEVER (B817) 0°C 740 C

WAL (AEEAT) -20°C %] 60°C

AR 20% 1| 80%

Wk e EAT: + 12,000 (3,658 m)
ANiZ47:  +40,000 (12,192 cm)

MTBF 50,000 /M (221S3) /30,000 /N (221531/22153L™)

ROHS =

EPEAT B (www.epeat.net)

f1.5E 100% ] [F]1

EHIAIE BSMI. CE Mark. FCC Class B, GOAST. SEMKO.
TCO5.1. TUV Ergo. TUV/GS. UL/cUL

B, M ) HLG,

N A EE g

& it

1. EPEAT Gold 8 Silver 1X£E Philips v M T 7= & B HB X A5 R4
HREPTEE K (HUX ) BEFENPIRGE, 1515 M) www.epeat.net.
2. WHUR AR, AT .
i 1] wwwi.philips.com/support ~ I~ 28 55 8T FRCAS (1) A T o
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4.1 SHEFRFFNLIRT

b0 sX7E
1920 x 1080 @ 60 Hz CHAUHI A
1920 x 1080 @ 60 Hz CECF%HiAN)
Bl #EESIEE
1920 x 1080 @ 60 Hz CEv%HiN)

31.47 720x400 70.09
3147 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.87
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00
& i

HE R, MR IRESE LA 2 HER 1920 X
1080@60Hz I TAERUR Fef: . ik 2 fE
SRBOR, T IO T HER K .
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5. FLIRETE

5. HEEIE

51 Bsh&HE

W PC rh2eh: T VESA DPM 345 s R ak
TR, BoRgsn] IAEANME I 3 3l R
DhHE. WiR 2k A EE . RAre e
ErNVERS TN, Bonesk s “MeiE”
Eﬁﬁ%%ﬁ@%%w%%wﬁﬂﬁ%ﬁ
T .

K| EE . LED
VESA ﬁﬁ *ljl./iﬁ ]Eﬁ Elﬁ 1%)?@ E@Jjjg%: Emé

o o 167 W
|| R | R | Temy | AE
i _ - <01W H
HE xw | = B CHLAL) R
)i | xm |- |- | T | X

T T R R R AR U DR

o [EATHER: 1920 x 1080

o XJLBLFE: 50%

o . 300 JEkF

o faif: 6500k A K%

& i

MR AR, AU AT S

7/
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6. BXRIE

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated and
compliance with European community” s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

TCO Displays 5.1 Information

Congratulations,
Your display is designed for both
you and the planet!

CERTIFIED

This display carries the TCO Certified label. This
ensures that the display is designed for minimal
impact on the climate and natural environment,
while offering all the performance expected
from top of the line electronic products. TCO
Certified is a third party verified program, where
every product model is tested by an accredited
independent test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Displays 5.1 requirements:

Visual Ergonomics

Good visual ergonomics in order to improve
the working environment for the user and to
reduce sight and strain problems. Important
parameters are:

* Light levels without color tint, Uniform
color and luminance, Wide color gamut

» Calibrated color temperature and gamma
curve

*  Wide luminance level, Dark black levels,
Low motion blur

29

Electrical Safety

*  Product fulfills rigorous safety standards
Emissions

* Low alternating electric and magnetic fields
emissions

* Low acoustic noise emissions

* Some of the Environmental features of the
TCO Displays 5.1 requirements

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001)

* Very low energy consumption both in on-
and standby mode

* Restrictions on chlorinated and brominated
flame retardants, plasticizer and polymers

* Restrictions on heavy metals such as
cadmium, mercury and lead (RoHS
compliance)

EPEAT
(www.epeat.net)
“The EPEAT (Electronic Product

% Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors based
on 51 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers
to secure market recognition for efforts

to reduce the environmental impact of its
products.”

Benefits of EPEAT
Reduce use of primary materials.
Reduce use of toxic materials.

Avoid the disposal of hazardous waste EPEAT” S
requirement that all registered products

meet ENERGY STAR’” s energy efficiency
specifications, means that these products will



consume less energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards:

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

*  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

*  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

*  2006/95/EC (Low Voltage Directive).
*  2004/108/EC (EMC Directive).

* 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

* The product also comply with the following
standards.

*  1509241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields forVisual Display).

¢ MPR-II (MPR1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO Displays 5.1 (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.

30

Energy Star Declaration
(Www.energystargov)

PZa N As an ENERGY STAR® Partner; we
% have determined that this product

d meets the ENERGY STAR®
guidelines for energy efficiency.

e Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B
digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to
provide reasonable protection against
harmful interference in a residential
installation. This equipment generates, uses
and can radiate radio frequency energy
and, if not installed and used in accordance
with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct
the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.



() Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo.

United States Only

e

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des régles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.
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CET appareil produit, utilise et peut
émettre des hyperfréquences qui, si
I'appareil n'est pas installé et utilisé selon
les consignes données, peuvent causer des
interférences nuisibles aux communications
radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre |'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

O Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.



EN 55022 Compliance (Czech Republic Only)

This dewvica belongs to catagory B davices ae described in EM 55022, unlesa it is spacifi-
cally stated that it is a Class A davics on tha specification labal. The following applies to
devicas in Class A of EN 55022 (redius of protection up to 30 meters). The ussr of the
devics is obliged to taks all stepa necessary to remove sources of intarferance o tala-
communication or other devicas.

Pokud neni na typowem &tithu poditade uvadeno, 8 spadé do do tidy A podie EN 55022,
spadd automaticky do thidy B podie EN 55022, Pro zafizeni zafazend do tfidy A (chranné
pésmo 30m) podle EN 55022 platl ndaledujicl. Dojde-ll k rulenl telekormunikatnich nebo
pnych zafizeni je ufvatal povinnen provést takowvd opatfgnl, aby ruSeni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer;, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circurt
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Ureydzemie powinno bd zasilane = priazds 2 preyigezonym obwedem ochronmym (griazdo 2
kotkiem). Wapdlpracujgee ze sobq uregdzenta (omputer, monator, drobarka) powinny byd mailame
2 hepn e dnddla

Instalacja elektrycma pomicsscsenta prwinna mwierd w preewodse Bazowym rereraowa ochrang
praoed wwarciami, wpostaci beeprecenika o wartescl mamionowe] mie wigkszej nik 164 (amperiw).
W el calkewitego wylpemmia uregdeens ¢ ¢ slect easalania, naledy wyjql wivezky kabla
easilajgcepo & proardka, kidre powiane zijdowsd sig w poblim urepdzeda @ bvé Batwo dostgpie

Faak beepleceefamwa "B” potwierdzs epodnodt uresdeendn @ wymagandaint beeplecaefiarwa
ukytkowania zawartvitl w FRN-SLT-4Z107 1 PR-BOEAMIS].

Pozostale instrukcje bezpieczensiwa

* Nie maledy urywad wiyezek sdapierowyeh lub wsuwad kodka abwodu ochrormepo 2 wiyeaki.
3 aledy wiyé preedhuzacea 3-zylowega 2
.

* System komputerowy ; e ciy wabespiecsyd prosd mawbymns, chwilowymi waersstmi hub spid-
eliminatara pracpigs, ureadsenia -:In[my:m wjacegs lub
salamia

becmklacen

* Malezy upewnic sig
bvly umleszizon

i |l n kablach ystemi kontputerow ego, orae aby kable e
gdere modna byloby na nie nadepywad lub potykad sig o mie,

* Mic maleky roslewad napopdaw and
*  Mie maledy wpychat zadnych pree
o spowodowal podar lub poraden)

pich plymly e svaten Kampulerowy.
i dhr alwordw systenm kempuleroweya, gévi moie
ydem, poproes ewarcie chementda wewngtranych

dowad sig 2 dala od greejnikéw @ sridel clepla. Porssdre,

* System komppulerowy poswinden £
i naleky blakawas alwordw ntylacyinych. Makedy unskac kladzensa hainych papserdw pod
kamputer ore umieszezanza kampulera w ciasnym micjsen ber mailiwasc cyrkulacyi powi-

elrr wokal niego.

32

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELMENERZIRE

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schaden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerédtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
Il 5 Abs. 4 der Rontgenverordnung erftillt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3.



6. HXME

1. Reparaturen nur durch Fachpersonal
durchgeftihrt werden.

2. Nur original-Ersatzteile verwendet werden.

3. Bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

O ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

P EAROHS

BEFEAN (AFESFRSREFATENE) (RBRAPERMRHS) -
LFa M T A S hr e EaR S YRR S Ra R

FREHZ R
2 (RRRCRT)

HEAERYRSATE
AR BEERYASNTE
i = & AULE EREE | FRER
(Pb) | (Ha) | (Cd) | (CrE+) (PEB) (PBDE)
55 o] (o] o] (0] @] (]
CRTIEFH x [¢] ] 0] 0] @)
BB TEITE X X ] 0] 8] [8)
PR AT x ] o 8] [0] [0)
TR x o o [€) [8] [®)
RS | x [o] o] 0] ] [¢]
* BB BEDR RS R AR TE R - BE - Eda - EERY
O FUTEAEEE AL A S AR A B
(AFERAPEEEENENTRESHE) MEORRERT
X FEEAEARYRE D EEAEAE MR RS R
(AFERFRTEEAEMRNEREGE) MENRRER | BRERET "X (B -
FEMERHSHINER (BT BRI )
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PURKHLIX [ R 15 B

i ] +49 01803 386 853 €0,09

WiH +44 0207 949 0069 A HhIE 1 2 H
IR +353 01 601 1161 A 1 2
A +34 902 888 785 €0,10

5 +358 09 2290 1908 A8 1 2
1] +33 082161 1658 €0,09

A 1 +30 00800 3122 1223 B 2

SN +39 840 320 041 €0,08

ff 2% +31 0900 0400 063 €0,10

LA +45 3525 8761 A HbE U 9l
£ 9 +47 2270 8250 A i U 9 H
Tt il +46 08 632 0016 A8 1 2
= +48 0223491505 A 1 2
B b ) +43 0810 000206 €0,07

EeiliN) +32 078 250851 €0,06

SRR +352 26 84 30 00 A HBAE 1 2 H
Gk +351 2 1359 1440 A 5 2
Fii -1 +41 02 23102116 A i 2
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M. Bogdanovich str: 155
BY - 220040 Minsk
Hif:  +37517 217 33 86

Service.BY

Petrus Brovky st. 19 — 101-B
220072, Minsk

Belarus

PRI

LAN JIz5%

140, Mimi Balkanska Str;
Office center Translog
Sofia, Bulgaria

g +359 2 960 2360

www.lan-service.bg

e

A- SLFF

General Consumer Information Center
800 100 697

i B L

Renoprom d.o.o.

Ljubljanska 4,

Sv. Nedjelja, 10431

Croatia

HE:  +385 1 3330974

FPJe.

FUJITSU SERVICES OU
Akadeemia tee 21G
EE-12618 Tallinn

Hi:  +372 6519900
www.ee.invia.fujitsu.com

) 4 A

Serware Szerviz

Vizimolnar u. 2-4

HU - 1031 Budapest

HLih:  +36 12426331
LI inbox@serware.hu

www.serware.hu

Profi Service Center Ltd.
123 Kulso-Vaci Street,
H-1044 Budapest ( Europe Center )

40

®) 4 H
HiG: +361 814 8080

m.andras@psc.hu

i i 4 Y.

ServiceNet LV

Jelgavas iela 36

LV - 1055 Riga,

HLif:  +371 7460399
HHEE:  serviss@servicenet.v
RYAGRT

ServiceNet LT

Gaiziunu G. 3

LT - 3009 KAUNAS

Huh:  +370 7400088
HFHBf:  servisas@servicenet.It

www.servicenet.lt

Z e

Blue Ridge Int'l Computers SRL
115, Mihai Eminescu St., Sector 2
RO - 020074 Bucharest

Hi6:  +40 21 2101969

FEIRYENE AR AL

Kim Tec d.o.o.

Viline vode bb, Slobodna zona
Beograd L12/3

11000 Belgrade

Serbia

Hiif:  +381 1120 70 684

gt

General Consumer Information Center
0800004551

Datalan Servisne Stredisko

Puchovska 8

SK - 831 06 Bratislava

HiG:  +421 2 49207155

HFHBf:  servis@datalan.sk

Wi SCe .

PC HAND

Brezovce 10

SI'-1236Trzin

Huh:  +3861 53008 24
LR EE:  servis@pchand.si



HEZ

CPS

18, Shelepihinskaya nab.
123290 Moscow
Russia
Hid:  +7(495)797 3434
THI

Z ARG R L) S
T H I

Tecpro

Telsizler Mah. 10

Kagithana, Istanbul, Turkey
HLIG: +90 212 444 4 832

552t

Comel

Shevchenko street 32

UA - 49030 Dnepropetrovsk

HLiG:  +380 562320045
www.csp-comel.com LLC Topaz Company

Topaz-Service Company,
Mishina str. 3,

Kiev

Ukraine-03151

Hih:  +38 044 245 73 31

AT AN E R, B TR AE
B IR RPA S DR A T o 454

B T OV IR] 2 s 1 i) e A A L AT R )
A, AR CREHE S Sy, IR
) AT R 3ty

W3k http//www.philips.com

IS

A B R AT PRI ORIE IR 55

T HL KR

Py

B RSS HLTE: 0800-7254101

s EHbE:  CIC.monitores@Philips.com
A2 R

8:00am - 8:00pm

41

B R 5 -
PR HiE: 0800 3330 856
HL ARtk : - CIC.monitores@Philips.com
A2 R
8:00am - 8:00pm
(RaAif)
Al 20 ASP-BRZ
Huhk:  Rod. Anhanguera, Km 49 Pista Sul -
Bairro: Terra Nova - Jundiai/SP
CEP 13210-877 — Brasil
Hii&: 5511 4531-8438
HFHB:  moacirminozzo@aoc.com.br

BT AR S

N B UL ASP-ARG

Hitik:  Azopardo 1480
(C1107ADZ) Cdad. de Buenos Aires
HiTh: 5411 4103-4113

HF I hlew@megatech.la

O X

WA 2

Nl: AGOS NETWORK PTY LTD

Huhik:  4/5 Dursley Road,Yenorra, NSW 2161,
Australia

Hi3: 1300 360 386

fREL:  +61-2-80808147

HLFHIE:  philips@agos.com.au

M55 m]: E— ~ ] 8:00am-7:30pm
BiILTESE

2~z Visual Group Ltd,

Hitik: 28 Walls Rd Penrose Auckland

Hii%: 0800 657447

¥ 09 5809607

HLF-1E1:  vairavindran@visualgroup.co.nz
M55 Te): A — ~ B ] 8:30am~5:30pm
A

k.

Zv#): Smart Pixels Technology Ltd.

Hiutik:  9/F Wilson Logistics Center 24-28 Kung

Kip Street Kwai Chung, N.T., Hong Kong.

HLG:  +852 2619 9639
fEEL. 48522148 3123
LT 1EF:  service@smartpixels.com.hk
WA BE— 22 F: 9:00am—



6:00pm, EHA/N:
ANE

vw]: Smart Pixels Technology Ltd.

Huhil:: RUA DO PE.ANT ROLIZ NO.2H R/C
+ SL(A) HONG FOK KOK, MACAU

R EMEBEE I H &

Hif:  (853)-0800-987

fEH: (853)-2855-2228

HL T IEfF:  service@smartpixels.com.hk
W25l I 2R 9:00am-
6:00pm, £H7S: 9:00am—1:00pm

9:00am—-1:00pm

H

5P [ ARG IR B S5

T HL KR -

& R4 g 4008 800 008
HL IRk philips_
helpdesk@vavotelecom.com

7 K: 8am - é6pm

I

vH]: REDINGTON INDIA LTD

Hibik:  SPL Guindy House, 95 Mount Road,
Chennai 600032, India

HLTE: 1800 425 6396

L HBLE:  tralservice@philipsmonitors.co.in
MRS mfie) . Al— ~ B
9:00AM~5:30PM;
SMS  “PHILIPS”  to 56677

E[TEEJE VU

vw]: PT. Gadingsari elektronika Prima
Hitik:  Kompleks Pinang 8, ]I. Ciputat raya No.
8F, Pondok Pinang. Jakarta

HLTE: 62 21 75909053, 75909056, 7511530
fEE: 62217510982

H T IE4:  gepta@cbn.net.id

MRS Ital: i ~ 2T
8:30am~4:30pm; A7\ 8:30am~4:30pm
JuH:  Jakarta, Bekasi, Krawang, Bogor, Depok,
Tangerang, Serpong, Serang

FoAh IR S5 R

1.ASC MEDAN

Hifl:  JLKakap No.32G, Medan
HTE: 62 614538920

42

JuE:  Medan, Aceh, Pematang Siantar,
Pakanbaru, Padang

2. ASCYOGYA

Hidil:: ]l Pembela Tanah Air No.15,Yogyakarta
Hiif: 62 274 564791

J5[H:  Yogyakarta, Solo, Semarang, Magelang

3.ASC SURABAYA

Hifik:  HI-TECH Mall Lt.2 Blok C1-12A
JlKusuma Bangsa 116-118, Surabaya

Hiif: 62 315353573

Julfl:  Surabaya, Malang, Pasuruan, Bojonegoro,
Kediri, Gersik

4. ASC BALI

Hotik:  JlPulau Nusa Penida No.28 Denpasar-
Bali

Hiif: 62813 31821822

Jul#l: Denpasar, Kuta, Nusa Dua, Gianyar,
Bedugul

5.ASC BANDUNG
Holik:  Segitiga Mas Kosambi Blok G-9 JlJend
A.Yani ,Bandung

HLLG: 6222 7237009

SERGER Bandung, Cirebon, Ciamis, Sukabumi
5[] «

/Nl PCS One Korea Ltd.

Holik:  112-2, Banpo-dong, Seocho-ku, Seoul,
137-040, Korea

Py U LG 080-600-6600

Hiif: 822591 1528

fEE.: 822595 9688

L IEF:  cic_korea@philips.com
RS5 I R] B — ~ BT 9:00AM~
6:00PM; A {75 9:00AM~1.00PM

HyoRPE

~wl: After Market Solutions (CE) Sdn Bhd
Hitik: Lot 6. Jalan 225/51A, 46100 Petaling
Jaya, Selangor DE, Malaysia.

HiT: 603 7953 3370

Philips & #j#&k:  1-800-880-180

fE: 6037953 3338

- HBF:  pceinfomy@philips.com

Hrgs el B — ~ B



8:15am~5:15pm; A 7S 9:00am~1:00pm
A I

Philips 71 91 2 Iz 25 0y

Hoht:  Mubarak manzil, 39, Garden Road,
Saddar, Karachi-74400

HiE: (9221) 273741116

R (9221) 2721167

- H5F:  care@philips.com
M5l BRI ~ 2N
09:30am~1:00pm & 2:00pm~5:30pm

FEHESE:

Aw]: Glee Electronics, Inc.

Motk Unit 1103-1104 11F The Taipan Place
Bldg. F. Ortigas Center Pasig City

HLiE:  (02) 633-4533 F| 34/ (02) 637-6559
#] 60

fEH: (02) 6334563

HL I jim.gawsont@glee.com.ph

M55 ie): B — ~ A ] 8:00am~6:00pm

BN -

7y #]: Philips Electronics Singapore Pte Ltd
(Philips Consumer Care Center)

Hodik:  620A Lorong 1 Toa Payoh, TP4 Building
Level 1, Singapore 319762

HLif:  (65) 6882 3999

fEEL:  (65) 62508037

HL 7 HI81F:  consumer.care sg@philips.com
MR o5 IR) . B — ~ B
9:00am~6:00pm; A2 7N 9:00am~1:00pm

il
sHl: FETEC.CO

Hifik:  No499, Ciwen Rd., Taoyuan City,
Taoyuan County 330, Taiwan

A Rgs: 0800-231-099

Hid: (03)3169920

fEH:  (03)3169930

LB knlinO8@xuite.net

M55 ie): A — ~ A ] 8:30am~7:00pm

2R
AT]: Axis Computer System Co, Ltd,
Mtk 1421 Soi Lardprao 94, Srivara Town

In Town Soi 3 Road, Wangthonglang, Bangkok

10310 Thailand

HLiG:  (662) 934-5498

fEH:  (662) 934-5499

HL- B axisS@axiscomputer.co.th
MR iiE] . AH— ~ AW
08:30am~05:30pm

R -

1.Ho Chi Minh City:

2vH]: FPT Service Informatic Company Ltd. -
Ho Chi Minh City Branch

Huhik:  207/4 Nguyen Van Thu Street, District 1,
HCM City

HiTH:  +84 8 38248007

fREL: +84 8 38248010

- HE1F:  Thanght@fpt.com.vn

JRG5INtE] . I — BRI 8:00am-
12:00pm, 1:30pm-5:30pm; A2 H/N:
8:00am-12:00pm

2. Danang City :

vwH]: FPT Service Informatic Company Ltd. -
Da nang Office

Hudi: 336 Le Duan Street - Thanh Khe
District - BPa Nang City

HLGE:  05113.562666; fkE: 05113562662
HiTE:  +84 511 3562666

fREL: +84 511 3562662

HLF-1EF:  khangndv@fpt.com.vn

MRS5 el R BRI T 8:00am-
12:00pm, 1:30pm-5:30pm; 2 HH/N:
8:00am-12:00pm

3. Can tho Province :

~w]: FPT Service Informatic Company Ltd. -
Can Tho Office

Huhilk: 71/4 Tran Phu Street, Ninh Kieu District,
Can tho City

HITE:  +84 5113.562666

fEH.: +84 5113.562662

H I nhieptv@fpt.com.vn

MRS ITE]: ALH— 2T 8:00am-
12:00pm, 1:30pm-5:30pm; ALII/N:
8:00am-12:00pm



AR

[F2E|e

A% HFK: Sylvara Technologies Pty Ltd
Hoht: Ho Address Palm Springs Centre
Christoffel Road Van Riebeeck Park Kempton
Park, South Africa

HLiG:  +27878084456

L +2711 391 1060

L HBLF:  customercare@philipssupport.
coza

MRS5 IR RH— ~ BT
08:00am~05:00pm

TR

B[ AT 1065 P K

ovwl: AL SHAHD COMPUTER LL.C

Hidik:  POBOX: 29024, DUBAI, UNITED
ARAB EMIRATES

H3G: 00971 4 2276525

fEH.: 00971 4 2276242

HL B L. shahd52@eim.ae

M5 al: - BLHHSS ~ S IHPY 9:00am~1:00pm
& 4:00pm- 8:00pm

LLEA

/vH] e Eastronics LTD

Hutik: 13 Rozanis St. PO.B. 39300, Tel Aviv

61392 Israel

HIE: AR LI SIER ST S 9k HiLIE 1-800-567000
(FEMRSS IR 2 5 20:00 Z B #k4T 972-50-

8353722)

fE¥L:  972-3-6458759

LB eastronics@eastronics.co.il

RS TR]: AHH ~ A2 #IPY 08:00 - 18:00

44
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8. HIPEHERRFNE JL o]

e

8.1 MIEH1(&

ARG P o] LU R 8. W Ae 2%
TRIX L ik Ja I AR AR, B S
Philips % ] IR S5 AR K R

B £ Riog

B/ (EiRLED %) .

o TR FEL YRR P v 4 ool e N FEL YA A A I
TN T A
TG, PR s s 1 T Y 34 A
T OFF (D) fiE, Rz s
ON (FFJi) fiE .

ZTEH (BjELED BxE®) .

o HARUFEALE T IFHLIRES
WA o 2R IE R B L
PR BN A e G kv A 4 il 4L
A, B s
A REREE T RETIRE .

RELRTR

Attention

il

Check cable connection

ff DR s o 2 8 IR AR BT L
(G2 WARENT TR

(RS RTINS 22 e SR DE T
B IR T SERLAL TR A

48

AUTO (B3h) =HEAEIER.
H s D REAGE T VAR L.
B EE AN R, Al LUE T OSD 3¢
AT T3
e i
AZhIhHEAE T DVI- B hi=, ohi%
PN T 2 H B2
BRI AE.
o VIMPATAAT MEHEER D R
Jy At W, SR E HYR R R
A HLYRZE
SLHIE Philips B IRGSAREKRER R .
12 @ElEIEE

BB,
i} OSD L¥shIrh i “Hsh” Thigi
MG E
i OSD =il Hh 1 B IR AR A /)
PR EUGAT H . IXANAE VGA Rk
EH

RELNEGES.
R A5 5 2 R A T A 7 i e 2 31 R
PRk, PC.

BEENGRR.
E E
= =
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8.2 SmartControl Premium F U (9]
R R &
B 1: SIGETI|[M—1 PC 113

|5 — PC B}, SmartControl
Premium TEIEER, E4ah?

[o] & T A8 PC, #4F SmartControl
Premium &5 TAFIEH . &
M), AT LM BR AR 5 o e
SmartControl Premium PLHfI{R 22255
EH IR BN AR P

8] 8% 2: SmartControl Premium LAB] T{EIE
=, BWMEARIE, E4ah?

BI%:  WERPAT T FYEAE, nTRET

BB R A KB
DIz o — U T & B 2
SRR SR B
HEAERGA KIS, 0 service pack
BN TR
1247 Windows Update Al 5 T 7~ 7 Fl/
BT OR Bl R 7
TE 3 7R S P Bl S 0 N R 3l T
Windows.,
J AR BRI, VE A B AR TR N, AR
S Bk > > T 28 RS
ARG S Wy M EL “Plug and Play
Monitor (RI4fRIH B osds)” » W 2 H
Bk MR SmartControl Premium,
RGO 7 A

O] RA 3. &ZE5E SmartControl Premium JF,
B &5 SmartControl Premium &
B, FTRERMEEEREZERETRKY
BFR, Ata?

Al aE K IEIERC 4S5 SmartControl
Premium ANFEZ. 1R G A2
s BRI —Fp e, 2N
AHI 25 =] 1Rty bR i #r i B
TG A KB o AR IRBNFE T o
MIER SmartControl Premium, 2K )5
HHT A — IR

WRAIARE TAE, WETEIER &%
AN SLH . VI Philips B,
K 215 A B ) SmartControl
Premium BXshFE .

]
i

: SRBPHFRERN, RERBS

52, Afta?

A fEAE B R IERC 28 IR S FE e AN A&
BOFTRCAS, Bl AN 58434 DDC/
Cl #1015 23 MAH Y. 2 7] 19 35
B M E TR IE R 2s KRR T
REWAFE . IR SmartControl
Premium, 2R & BT %3 —1K.

Attention

Theft mode enabled

R 5 I TR &ETIRERY PIN. B4
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2
N T e BN T AL R
IR 45 v USSR AL G OIE
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8.3 —HE'E NlLIn)ERARE

ia]

ia]
[o]

ig]
=

M1 RERTREN, MREELETR
“Cannot display this video mode”

(LEETERINRR) , NEA

72
e UL R R A R

1920 x 1080 @60Hz.
WP, SRIEH PC e 16
T 5 5

1F Windows TG rf, e R0 & /1%
Wl . EFSHIRARE L, EF R
bR, 7Eonyshlttey, L8 “ix
BRI, EWRCEENR T “HEm
X3 7 HEH, s 2] 1920 x 1080
B

I “mBJgrE” , BRI RN
60Hz, RJE . “HfiE” .

o A EENL, AR )E AT PR
2 F1 3 AN PC B AE 1920 x 1080
@60Hz,

KPHENL, Wit RS R4S,
2 Philips s 8.
FIITFWonss Y, ARJE4TIF PC HLYk .
2. BIETRSRERAMRFERS D?
E: BWAERAS R AL 60Hz, 7
i R R I a7 W A=A P =
W 75Hz A & REIHBR TPt

3. ALY inf # iem XEBH4A
F? WL EIRHFEF Cinf FA
dicm) ?

B e BRI IRE R T S .
F2 4 User Manual ( P M) H1
UL LI IREN L 56— IR i
et FEMITRES T BN
IXKENFE Cinf Al icm 3C£F) BRI
IE R N 4R S E AN T H &)
PR aERGCEL. Bones ks iy

Cinf Al icm ) ¥4 Bl ek,

B4 MTEESHE

B MR /B RIRER R
L YeE T T AR . fE T

51

PAFE Windows® [ B (1) Display
properties MR T (1 73 HER o

)7 5: AR RSERAHENMREEA
In?

B1%: N OK (Hhie) #1dl, Rk
B (Reset)' HI Al 4=k 2 42
JREGH ] WA

)k 6: LCD REEEINEIE?

E%: —WinE, @A R
W, I H NG 1B el b 4
e AR R . AR R gs i,
W) T IARER IR . XA REN 52
i PR A

B 7. A& LCD RMmE?

BI%: AT RS .
MEGHEN, EEHRNEE. 152
P W RS . S, . O
S H A

B8 8: KRAIMUE N B RERMEIREN?
EI%: "R, &rTLLEN OSD # ik i
g s, BRI R .

1% “Hfie” Wos OSD (hEH:
IN) SEHL
¥ Cm Rk ERE Bl ik
i, ARJEHE “Hae” SEANGE
B, AN =1NEE,
1. . uFs 6 MRE, R
5000K. 6500K. 7500K. 8200K. 9300K
F1 11500K. B¢ EAE 5000K yu[Hl A 1,
AR FEss “BRf” , BRI ai;
iy 11500K I Eos “w i, 2RI
[y S RERERTR
2. SRGB: IX/EMTRAEAIFB S (Ui AH
Ml ongs. FTEIHL. HEE) 2 [h)
IERAAS e B ) — FhbR A
3. AP EX: AP AL L . 2Rt f
Wi, NTERE E O =R PO A .
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EHM, 6504K,

BER 9: AT LUE IR B RESiEREE PC.
T {Euksk Mac 05 ?
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HER) PC. Mac Fl TAERS 52 232 o
PR AR IE R R Mac RS,
BT — RGN As . AR
PG R, WS Philips 895
REILR

(@)@ 10: Philips T2 7~&8 ] LARDFRED ARG ?

[B] % :

E%: ALl XEEIRESLE Windows 7/
Vista/XP/NT. Mac OSX. Linux [
RFHE R Th g .

B 11: BossEREHIBEGRBRES
eiEftar

EE . KA ) T B i R A

B REAE b B K “IgED”
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T 1) PR 5 o T S I SO L K
WA . L] R R (R
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)R8 12: AT ABRTRFETHLFAEE
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